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In this booklet you will fi nd everything you need to know 
to get you up and running with Quicken 2009, whether 
you are a new or existing user. We strongly recommend 
that you read this booklet carefully and follow the steps 
outlined to ensure your installation process is as smooth 
as possible.

If you have anti-virus software installed on your PC, 
it is recommended that you disconnect your Internet 
connection and then disable your anti-virus software, as 
it may interfere with software installation.

If you are upgrading from an earlier version of Quicken, 
pay special attention to the notes describing features 
that have been changed or added to Quicken since your 
last upgrade. You may need to perform additional steps 
in the upgrade process, depending on how old your 
current version is. The headings in each section provide 
a guide to fi nding the instructions relevant to you.

Quicken 2009 Installation and Upgrade Guide, Version 1.0
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System Requirements

To install and use Quicken 2009 you need: 

IBM® or compatible Pentium® II 300 (Pentium III 450  •

recommended) with 128MB RAM

Microsoft® Windows® 2000/XP/Vista® operating  •

system

Microsoft Excel® XP or higher required to start the  •

FIDO Superannuation Calculator (Personal Plus and 
Home & Business only)

185MB of disk space for Quicken installation •

Microsoft Internet Explorer® 6.0 (provided on  •

installation CD-ROM, requires 55MB)

SVGA 1024 x 768 display with 16-bit colour •

800 x 600 resolution (1024 x 768 recommended) •

Works with any printer supported by Windows 2000/ •

XP/Vista operating systems*

Double speed CD-ROM (6x or higher recommended) •

All online features/services (such as online  •

investment tracking) require Internet access with at 
least a 56 Kbps modem (high speed Internet access 
recommended)

Latest service packs for Windows and Internet Explorer 
recommended.
* Windows 64 bit is not supported
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Existing Quicken users
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Changes for 2009

Quicken includes many changes and new features in this 
release. An overview of changes and features you should 
note is provided below.

Your Installed Quicken Products

Quicken 2009 will uninstall any Quicken product 
previously installed on your PC. The data fi les will remain 
in the same location they were in before the installation 
of Quicken 2009.

Changes to Cash Flow Forecasts

After upgrading, Quicken may not be able to recognise 
cash fl ow scenarios that you have saved in a previous 
version. If this occurs, you will need to re-create the 
forecast after the upgrade. 

To re-create the forecast after the upgrade:

Choose1.  Planning menu > Cash Flow Forecast.

Choose 2. Options > Accounts to customise the 
accounts for the scenario. Click OK.

Choose 3. Options > Manage Scenarios. 

Click 4. New and enter a Scenario Name, then click OK 
to save the new scenario.

Updating your stocks from Quicken Version 

8 or earlier

Quicken includes new features for tracking your 
investments, such as the ability to download stock prices 
from different exchanges (Australia, NZ, US). If you have 
upgraded from Version 8, the exchange and asset class 
for each security will be set to your default country. You 
must specify the asset class and exchange for each 
security after you have upgraded to Quicken 2009. 
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To specify the asset class and exchange for a security:

Choose 1. Investment menu > Security List.

Highlight the individual security and then click 2. Edit. 
You can assign an exchange and asset class from 
the relevant drop-down lists. If a ‘Symbol Change 

Affects Price History’ message appears, click OK to 
copy the quotes.

Carbon Footprint Calculator

The Carbon Footprint Calculator, which is available in 
Quicken Personal Plus and Quicken Home & Business 
2009, requires Microsoft Offi ce Excel® 2000, XP, 2003 or 
2007. Other programs that can open Excel-format fi les 
are not supported for this release.

Reckon Tools Backup 

To use the Quicken 2009 online backup feature, you 
will need to install the Reckon Tools Backup Desktop 
application, which is available on the Quicken 2009 CD. 
If you have installed an earlier version of the Reckon 
Tools Backup Desktop application, you will need to 
uninstall that software and install the new version from 
the Quicken 2009 CD.

Pin Vault Password

If you currently have a Pin Vault password setup on your 
data fi le, please remove it before upgrading to Quicken 
2009, as this feature is no longer available in the 
product.

Home Currency

If you have previously selected a home currency other 
than Australia, in CashBook 2004 or in earlier versions of 
Quicken, please change the Home Currency to Australia 
before upgrading to Quicken 2009. This will ensure that 
the BAS report can be properly displayed.
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Changes to Budgeting

Many features of Quicken have been updated in response 
to feedback from Quicken users. The budgeting feature 
and its user interface have been customised to make the 
feature easier to use. As a result, you may notice that 
budgets no longer use a spreadsheet format or show 
projected balances in Quicken 2009.

Budget Reports

Please note that in the Quicken 2009 release, budget 
reporting has changed to a July-to-June fi nancial year for 
Australia, and to an April-to-March fi nancial year for New 
Zealand.

Classes become Tags

During the upgrade to Quicken 2009, classes are 
renamed to tags and placed in the tags list. Tags 
replace classes in Quicken 2009, and offer improved 
functionality. When you have completed the upgrade 
process, you will fi nd that all your classes are present in 
the Tag List.  Choose Tools menu > Tag List to view your 
tags.

Category Groups

If you created your own category groups in an earlier 
version of Quicken, they may not be maintained during 
the upgrade to Quicken 2009.

To re-create category groups and reassign them:

Choose 1. Tools menu > Category List.

Select the relevant category from the list and click 2. 
Edit. 

Choose 3. Group > New. Enter a new group name and 
click OK. 

Continue to create new group names as necessary 
and assign them to relevant categories.
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Billminder is no longer available in Quicken

If you have upgraded from Quicken 2004 or earlier, you 
will notice that the Billminder feature has been removed. 
This was done in response to customer feedback, which 
advised us that Billminder was not a valued feature.

Upgrading a data fi le from Quicken 2004 or 

earlier versions

Savings accounts created in Quicken 2004 or earlier 
versions do not include an Account Location fi eld. 
However, in Quicken 2009 the Account Location fi eld 
cannot be empty. Thus, after upgrading from Quicken 
2004 or earlier versions to Quicken 2009, savings 
accounts will display “Spending” in the Account Location 
fi eld. 

The new In / Out / What’s left feature allows users to 
immediately see where their money is going using various 
charts and tables. This feature displays information using 
the savings accounts that show Spending in the Account 

Location fi eld.

If you are upgrading from Quicken 2004 or an earlier 
version to Quicken 2009 and have savings accounts set 
up, you should change the value in the Account Location 
fi eld from Spending to Saving. This ensures the In / Out / 

What’s left feature displays the correct information.

To change the value in the Account Location fi eld:

Place the cursor over the account name in the 1. at-a-

glance bar.

Right-click on the account name and select 2. Edit 

Account. 

The Account details window opens.

Change the 3. Account Location fi eld from Spending to 
Saving.
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If you upgrade a data fi le that contains a 

linked account

The Quicken 2009 Investment Activity Report reports on 
all transactions from linked accounts. New transactions 
entered in the linked accounts in Quicken 2009 will 
continue to appear in the Investment Activity Report.

Upgrading from CashBook 2003 or 

CashBook 2004

The Itemised Category Report in Quicken 2009 does not 
include account balances forward by default. 

To include account balances forward:

Open the 1. Itemised Category Report.

Click 2. Customise.

Click the 3. Advanced tab.

Select 4. Include All from the Transfers drop-down list.

If you have at any stage had ‘return of capital’ 
transactions entered in an investment account that has 
a linked bank account, the Itemised Category Report will 
not add the return of capital transactions to the total.

Opening your original data fi le after 

upgrading to Quicken 2009 from any 

earlier version of Quicken or CashBook

When you upgrade to Quicken 2009, a backup copy of 
your original data fi le is automatically placed in a folder 
called OldFiles, which is located in the same folder as the 
data fi le you are upgrading. Use this backup copy if you 
need to view your original fi le in your previous version. 
You can choose File menu > Restore or File menu > Open 
to open the fi le.
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Access permissions

If you encounter the error message “Installshield Error 
1608: Unable to create InstallDriver instance, unable to 
install”, you will need to change the DCOM fi le on your 
computer in order to install Quicken 2009 successfully.

Note: These steps apply to Microsoft Windows 2000 
operating system, and may vary for other versions of 
Windows operating systems. Please refer to Windows 
Help for instructions specifi c for your version.

To change the DCOM fi le on your computer:

Click the 1. Start button and choose Run. 

Type 2. dcomcnfg and click OK.

Click the 3. Default Security tab.

In the 4. Default Access Permissions section, click Edit 

Default.

Check that 5. Allow Access is selected, and then click 
OK.

Try installing again. If you receive the error message 6. 
again, continue to step 8.

If the issue continues to occur, install Quicken in 7. 
Safe Mode, and then restart your computer. If you 
receive the error message again, continue to step 8.

If the issue still persists, create a new Windows user 8. 
account with administrator permissions.

Click the 9. Start button and choose Settings > Control 

Panel. 

Double-click 10. Users and Passwords.

Click the 11. User tab.

Click 12. Add User, and then follow the onscreen 
instructions to create a user account with 
administrative permissions.
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Restart your computer and log in with the new 13. 
administrator account.

Attempt to install or uninstall the Quicken program 14. 
again.

Other installation problems

If you experience any other problems during installation, 
consider whether any of the following may be the source 
of your problems:

Are you logged onto your PC as the Administrator? •

Have you shut down all applications? •

Is your anti-virus software blocking your installation of  •

Quicken?

If none of the above appear to be causing your problem, 
try installing Quicken in Safe Mode. For instructions on 
restarting your PC in Safe Mode, refer to your Windows 
Help. After you have installed Quicken in Safe Mode, 
do not try to open it immediately. First, restart your PC 
in normal mode and make sure you are connected to 
the Internet. Open Quicken and enter your Installation 
Key Code to Activate. If you do not have an Internet 
connection, click Cancel to close any activation 
messages and call Reckon Customer Support to Activate 
over the telephone.

Still having problems? Check the Quicken online 
knowledge browser at http://www.quicken.com.au/
Support/FAQs.aspx and search the database for “error 
message”.
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Determine your upgrade path

Find your current Quicken version in the list below and 
check the upgrade path. If there is a tick in the row for 
your current version, then you can upgrade directly to 
Quicken 2009.

If ‘CashBook 2004’ appears in the row for your current 
version, then you must fi rst upgrade your data fi le to 
CashBook 2004 and then to Quicken 2009. You must do 
this before installing Quicken 2009. Follow the upgrade 
instructions on the following pages carefully.

Your current version
Home & 

Business 2009

Personal 

Plus 2009

Personal

2009

Home & Business 2008

Personal Plus 2008

Personal 2008

Home & Business 2007

Personal Plus 2007

Personal 2007

Home & Business 

2005/2006

Personal Plus 2006

Personal 2006

Personal Plus 2005

Personal 2005

CashBook 2004+

Personal Plus 2004

Personal 2004 **
CashBook 2003+

Personal Plus SE 2002 **
Personal 2002 **

CashBook v8
CashBook 

2004*

Personal Plus v8
CashBook 

2004*

CashBook 

2004*

Personal v8
CashBook 

2004*

CashBook 

2004*

CashBook 

2004*
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+ Some CashBook features do not exist in Home & 
Business 2009.

* CashBook 2004 Trial is provided on your Quicken 2009 
CD. Browse the CD, fi nd the CV folder and then locate the 
CBTrial folder then run the Setup.exe.

**If you have an investment account you cannot upgrade 
directly to Personal 2009, you must purchase Personal 
Plus 2009 or Home & Business 2009. 

Updrade Software Located on CD

CashBook 2004 \\CV\CBTrial
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Prepare your company data fi le for 

upgrade

We strongly recommend that you follow the steps below 
to protect your company data and ensure its accuracy.

Back up your data fi le1. 

To back up your fi le, choose File menu > Backup. 
Select the fi le you want to back up and the location 
you want to back it up to. For more information 
on how to back up, please refer to the User Guide 
(available on the Quicken CD) or in-product Help for 
“Backing up your data”.

Validate your data fi le2. 

Ensure the data fi le you are using is validated before 
upgrading your software. Validating a data fi le allows 
Quicken to verify its integrity. Choose File menu > 

File Operations > Validate. Find the data fi le you want 
to validate and click OK. You will need to repeat this 
process for every data fi le you want to upgrade.

Remove any passwords associated with your data 3. 
fi le.

To remove your password from your data fi le, choose 
File menu > Passwords > File or Transaction.

Print a selection of Reports from the data fi le in your 4. 
currently installed version

Print a record of all business Tax reports for previous 
periods (e.g. Tax Detail, BAS). You can use these 
Reports after upgrading to confi rm the data which 
appears in the upgraded version is correct.

Note: Some reports in Quicken 2009 have different 
default settings to previous Quicken versions. In 
some cases, these reports may require you to 
customise the report to obtain the same fi gures.
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Ensure ALL unapplied Adjustments/Credits are 5. 
applied to an Invoice or deleted.

Delete all Scheduled Invoices and Payments (taking 6. 
note of details).

Take note of your Quicken Settings / Preferences7. 

Some of the settings within your company fi le revert 
to the default settings of Quicken 2009.  Make a 
note of your personal settings and preferences so 
you can apply these to your upgraded data fi le.

Saved Reports will not be available after the 8. 
conversion

We recommend that you print any Saved Reports 
from your current version beforehand, for your 
reference.

ABN and Branch number will need to be re-entered in 9. 
your data fi le after conversion

If you have customised templates10. 

Customised Invoice and Estimate templates from 
your previous version only convert directly to Quicken 
Home & Business if you install Home & Business 
in the same installation directory as your previous 
version of Quicken, once the previous version has 
been uninstalled.

If you have a linked investment account11. 

If you upgrade a Quicken company fi le that contains 
a linked investment account, the Investment Activity 
Report in Quicken 2009 will always report on all 
transactions from both accounts. To avoid this, you 
should un-link the accounts in your previous version 
prior to upgrading.
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Upgrading your Quicken software

Reminder: before upgrading, have you:

Printed a selection of reports from your original  •

Quicken program.

Created a backup of your original company fi le and  •

validated it.

To upgrade from Quicken Personal v8 or Personal Plus v8 
or CashBook v8, continue reading this page.

To upgrade from a different version, start on page 19.

Upgrading from Quicken Personal v8 or Personal 

Plus v8 or CashBook v8

Quicken Personal v8, Personal Plus v8 and CashBook v8 
have now been sunsetted. In order to convert your data 
fi le to Quicken 2009, you need to step your data fi le up 
through CashBook 2004. The CashBook 2004 Trial is 
available on the Quicken 2009 CD. 

Install CashBook 2004 Trial

Make sure that your current version of Quicken 1. 
(Personal v8 or Personal Plus v8 or CashBook v8) is 
backed up on disk then close Quicken.

Insert your Quicken 2009 CD into your CD-ROM drive.  2. 
The installation screen automatically appears. If this 
does not happen, click the Start button and choose 
Run, then type d:\autorun.exe (where d is your CD-
ROM drive) and click OK.

Browse CD. Then Browse to CV and then to CBTrial, 3. 
then click setup.exe

Click 4. Yes when prompted to install CashBook 2004.

Click 5. Next when the Welcome screen appears.

Select where you would like to install CashBook 6. 
2004 and click Next.
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Note: You should install CashBook 2004 in the same 
installation directory as your previous version (default 
location is C:\Program Files\quickenw).

Click 7. Yes to uninstall your previous version of 
Quicken.  This will not affect your existing Quicken 
data.

Follow the prompts to uninstall your previous version 8. 
of Quicken.

Note: Click No to All when prompted to remove all 
shared fi les.

When the uninstall process is complete, click 9. OK.

Click the 10. Start button and choose Run, then type 
d:\autorun.exe (where d is your CD-ROM drive) 
and click OK.

Select 11. Upgrade Software.

Click 12. Install CashBook 2004 Trial.

Follow the prompts to install CashBook 2004.13. 

Note: You should install CashBook 2004 in the same 
installation directory as your previous version (default 
location is C:\Program Files\quickenw).

Restart your computer to complete the installation of 14. 
CashBook 2004.

Launch CashBook 2004 and upgrade your company 15. 
fi le by clicking OK. If you have more than one 
company fi le, each must be upgraded by choosing 
File menu > Open and selecting the company fi le.

Once you have completed upgrading your company 16. 
fi le(s) to CashBook 2004, follow the instructions 
under – Upgrading from Quicken Personal 2002, 
Personal Plus 2002 (or 2002 SE), CashBook 2003, 
Personal 2004, Personal Plus 2004, CashBook 
2004, Personal 2005, Personal Plus 2005, Home & 
Business 2005/06, Personal 2006, Personal Plus 
2006, Personal 2007, Personal Plus 2007 or Home 
& Business 2007.
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Upgrading from Quicken Personal 2002, Personal 

Plus 2002 (or 2002 SE), CashBook 2003, Personal 

2004, Personal Plus 2004, CashBook 2004, 

Personal 2005, Personal Plus 2005, Home & 

Business 2005/06, Personal 2006, Personal Plus 

2006, Personal 2007, Personal Plus 2007, Home & 

Business 2007, Personal 2008, Personal Plus 2008 

or Home & Business 2008

You may directly upgrade your data fi le to Quicken 2009.

Note: When you upgrade to Quicken 2009, a backup of 
your original fi le is automatically placed in a folder in your 
Quicken directory. See Other issues for instructions.  

Follow the instructions below to upgrade your data fi le to 
Quicken 2009.

Ensure you have completed the instructions in 1. 
section “Prepare your data fi le for upgrade” on page 
15. Make sure your current version of Quicken is 
closed.

Insert the Quicken 2009 CD into the CD-ROM drive.  2. 
The installation screen automatically appears. If this 
does not happen, click the Start button and choose 
Run, then type d:\autorun.exe (where d is your 
CD-ROM drive) and click OK.

Select your region.3. 

Click 4. Begin.

Follow the onscreen instructions.5. 

Note:  If you have an older Quicken version (v2004 
or below) on your PC, you may receive a message 
requesting that you exit and uninstall before installing 
Quicken 2009. When you return to install Quicken 
2009, you may be asked to Remove Shared Files? 
Select Yes to all.

Select 6. Yes to restart your computer, and click Finish.
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The fi rst time you open Quicken 2009, you will 7. 
be required to Activate by entering your Quicken 
Installation Key Code (IKC). The activation process 
will take place automatically over the Internet. If 
you do not have an Internet connection, click Cancel 
on the messages that appear and call Customer 
Support to complete the process over the telephone.

The fi rst time you open your company fi le in Quicken 8. 
2009, the upgrade process begins. Read the upgrade 
message and click OK if your want to continue. If you 
have a large data fi le, or if you have investment data, 
the upgrade may take several minutes.

Follow the prompts to set up your company fi le in 9. 
Quicken 2009. Click Done when you have fi nished.

After you upgrade

Check your data in the upgraded version. Run the  •

same reports you ran before upgrading and compare 
them to confi rm that the data matches. If your data 
does not match the previous version, try to identify 
where the problem is. For example, it may relate 
specifi cally to categories or transactions.

Check the Quicken settings and preferences against  •

the settings you noted before upgrading your 
company fi le.

Explore Quicken’s many new features in What’s new  •

in Quicken under the Help menu.

Back up your data fi le. •

DO NOT OVERWRITE YOUR PREVIOUS BACKUP!

You may choose to back up your company fi le to a CD-
ROM or other storage media. Make sure that you label 
each disk correctly and store it in a safe place in case 
you need them later. Do not overwrite this backup. (You 
can fi nd instructions for backing up your data in the user 
guide, which is available on the Quicken 2009 CD-ROM.)
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New Quicken users
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Prepare to install Quicken 2009

Before you install Quicken, you need to:

Log on to your PC as the Administrator or have  •

Administrator rights.

Close any programs running on your PC. •

Disconnect from the Internet. •

Disable your anti-virus and fi rewall applications. •

After you have installed Quicken, be sure to re-enable 
your anti-virus and fi rewall applications. Then, reconnect 
to the Internet so that you can activate your Quicken 
product online.

Install Quicken 2009

To install Quicken:

Insert the Quicken 2009 CD into the CD-ROM drive.1. 

If the installation window does not open 
automatically, click the Start button in the Windows 
taskbar and choose Run, then type d:\autorun.
exe, where d is your CD-ROM drive, and then click 
OK.

Select your region.2. 

Click 3. Begin.

Follow the onscreen instructions to install Quicken.4. 

Note: You will fi nd your Installation Key Code (IKC) on 
your CD case or in the letter you received with your 
CD-ROM.

Reboot your PC to complete the Quicken installation.5. 

Double-click the Quicken icon on your desktop to 6. 
open Quicken 2009.

Start a new fi le, or browse the features of Quicken 
2009 using the sample fi le.
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Activate Quicken

After you have installed and opened your software, you 
are prompted to activate Quicken 2009. 

You will fi nd your Installation Key Code (IKC) on your CD 
case or in the letter you received with your CD-ROM. You 
need an Internet connection to activate online.
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Notes
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Quicken 2009

End User Licence 

Agreement
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Quicken 2009 

End User Licence Agreement

THIS IS AN IMPORTANT DOCUMENT. PLEASE READ IT 
CAREFULLY. 

This is a contract between Reckon Limited (ACN 003 348 
730) (Reckon) and you.  By using the Payroll Premier software 
supplied with this document, and the related user guides 
and materials (together the Software), you agree to be bound 
by the terms of this Licence.  This Licence covers copies 
of the Software provided for evaluation or trial purposes, 
subscription versions and non-subscription or full versions of 
the Software. Some Licence provisions may not be applicable 
to you, depending on the particular version of the Software you 
have purchased or if you are using the Software for evaluation 
purposes.  The defi ned terms and the rules of interpretation in 
this Licence are set out in clause 12.

Important: There are a number of technical features within 
the Software that may affect your ability to continue to use the 
Software.  These are outlined in more detail in the terms of the 
Licence, but in summary:

you are purchasing the right to use the Software, not to own  •

it;

if you have been provided with a Trial Version, you may only  •

use the Software on a temporary basis to evaluate the 
Software’s functionality and suitability for your requirements;

the Software contains registration and activation processes  •

to guard against illegal copying; 

to continue using the Software, those processes require you  •

to verify your compliance with the terms under which you 
are licensed to use the software (for example: the number 
of computers on which the software is installed) and to 
permit continued reactivation of the Software from time to 
time.  This involves, in all versions, periodically verifying your 
licence details, and in the subscription version, renewing 
your subscription when it falls due. Reckon may also verify 
subscription customers during a subscription period and 
not only at renewal. You will also need to reactivate your 
Software if you want to reinstall it (for example, if you 
upgrade your computer or if you have a hard drive failure, 
and you may incur a technical support cost for this);

when you purchase the Software or during the course of  •

your subscription you will be provided with an installation key 
code.  Please keep the installation key code in a safe place.  
You may need it when you first install or re-install
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1.  LICENCE

Evaluation licence(a) : If Reckon has provided a Trial Version 
of the Software to you, your rights to use the Trial Version 
are solely as set out in clause 10.

Licence to use(b) : Reckon grants you a personal, non-
exclusive, non-transferable, limited licence to use the 
Software on the terms of this Licence for the period 
determined in accordance with clause 8.

No transfer of copyright(c) : The Software is licensed not 
sold, despite any reference to “purchase” or “sale” in 
this Licence or in any invoice or purchase order for the 
supply of the Software.  Reckon reserves all rights not 
expressly granted to you.  Reckon Limited is the owner 
of copyright in the Software and retains ownership of 

(if permitted) the Software and to reactivate the Software. 
Please note if you lose your installation key code that it will 
not be replaced by Reckon and you will not be able to install 
or reactivate the Software;

you also need a licence key to reactivate your Software.  In  •

addition, with some older versions of the Software, you will 
not be able to re-install or reactivate the Software if you do 
not have your installation key code - see details below on 
Reckon’s sunset policy;

there will be no charge to activate the Software initially or  •

to reactivate your Software when you verify your licence 
details or renew a subscription. Reckon may charge you a 
fee for technical support if it needs to reissue a licence key 
provided also that the version of the Software you are using 
has not been ‘sunsetted’ as explained below. Reckon may 
also charge a fee if you need to reactivate the Software in 
other circumstances (for example, if you need to reinstall the 
Software if you upgrade your computer or due to a hard drive 
failure); 

if you do not verify your licence details or renew your  •

subscription (as applicable) within the required period, 
the Software may continue to operate but with impaired 
functionality or you may not be able to access the Software 
at all (including printing out or viewing any of your data or 
records); and

Reckon has a ‘sunset policy’ which means that technical  •

support is not available for some older versions of the 
Software.  This includes the ability to install or re-install that 
Software for any reason if you have lost your installation key 
code for those old versions. If you wish to continue using the 
Software in those circumstances, you will need to purchase a 
new copy of the current version of that Software.
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the copyright and all other intellectual property rights 
in the Software and is protected by copyright law and 
international copyright treaty.

2. YOUR PERMITTED USE OF THE SOFTWARE

Single use licence(a) : If you have purchased a single user 
licence, you:

may install the Software once, on one computer (i) 
only. However, if you wish to reinstall the Software 
(for example, if you need to install the Software on a 
replacement computer), then clause 3 will apply; and

must ensure that the Software is used by one person (ii) 
only at any one time. 

Additional licences(b) : Subject to any multi-user licence that 
you have obtained, if:

more than one person is to use the Software at the (i) 
same time; or

the Software is to be installed on more than one (ii) 
computer

then you must obtain an additional licence for each 
additional person or computer.

Premier Version(c) 

If you have purchased a full version of QuickBooks 
Premier, this Licence entitles you to load the Software on 
up to three computers (for use by a single processing unit 
only on each computer) for use by up to three individuals 
simultaneously. If you wish to install the Software 
on more than three computers you must purchase 
additional licenses that will permit up to fi ve users to 
simultaneously access a data fi le. If Reckon releases 
the next release of QuickBooks Premier while you are a 
member of the Advantage programme subject to its terms 
and conditions, you will be permitted to make a total of 
fi ve installations.

If you have purchased a subscription version of 
QuickBooks Premier, this licence entitles you to load the 
Software on up to fi ve computers (for use by a single 
processing unit only on each computer) for use by up to 
fi ve individuals simultaneously. If you wish to install the 
Software on more than fi ve computers you must purchase 
another full version or a subscription version of that 
software but for simultaneous access you will need to 
upgrade to an appropriate version that permits more than 
fi ve users to simultaneously access a data fi le.
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Accountant Edition(d) 

If you are an eligible Professional Partner who has 
purchased a full version of QuickBooks Accountant 
Edition, this Licence entitles you to load the Software on 
up to fi ve computers (for use by a single processing unit 
only on each computer) for use by up to fi ve individuals 
simultaneously. In some special cases with written 
approval of Reckon only, certain Professional Partners 
may be allowed to load the Software on up to 25 
computers. However, only 5 simultaneous users can have 
access to any single data fi le

Enterprise Version(e) 

If you have purchased the QuickBooks Enterprise (i) 
version of the Software, this Licence entitles you to 
load the Software on up to ten computers with the 
option to load up to another 20 computers at the 
applicable charge (for use by a single processing unit 
only on each computer) for use by up to ten or more 
individuals up to a maximum of 30 (as permitted by 
the Licence purchased) simultaneously. You may not 
load the Software onto any further computers.

If you have purchased the QuickBooks Enterprise (ii) 
Accountants version of the Software, this Licence 
entitles you to load the Software onto one computer 
(for use by a single processing unit). You may not 
load the Software onto any further computers.

General restrictions(f) : You must not:

use or rely upon the Software for any purpose or in (i) 
any manner for which the Software is not warranted;

copy, reproduce, translate, adapt, vary, merge or (ii) 
modify or create any derivative work based on the 
Software;

reverse engineer, decompile, disassemble, (iii) 
reconfi gure or otherwise attempt to discover the 
source code of the Software; or

sell, market, network, transfer, lease, license, (iv) 
sub-license, rent, lend or otherwise dispose of or 
distribute the Software or use the Software to provide 
a bureau service.

Licence verifi cation(g) : Upon written request from Reckon, 
including by e-mail, you agree to provide Reckon with a 
signed certifi cate:

verifying that the Software is being used fully in (i) 
accordance with this Licence, including user and 
machine limitations; and 
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listing locations, types and serial numbers of (ii) 
equipment on which the Software is run.

You agree to allow Reckon to use and disclose any 
personal details provided to Reckon in connection with 
this Licence in accordance with Reckon’s then current 
privacy policy displayed on Reckon’s website.

Audit rights(h) : Reckon may also audit the number of 
copies of the Software in use or possession by you, the 
equipment on which the Software is installed or used 
and the number of users using the Software. Audits will 
be conducted in your normal business hours, or upon 
reasonable prior written notice, at Reckon’s expense. 
If the audit reveals underpaid or unpaid fees due to 
Reckon, you will be invoiced for them based on Reckon’s 
then current price list, and if these exceed 5% of the 
license fees you have already paid, you will also be 
invoiced for the cost of the audit.

3. PRODUCT ACTIVATION AND VERIFICATION 

Initial registration and verifying licence details(a) : This 
Software may contain technology that protects Reckon 
against illegal copying. As a consequence, you may be 
required to:

register your details during the initial installation (i) 
(including your name, contact details and details of 
the hardware on which the Software will be installed 
(if this is not done automatically by the Software);

if you have a full version, have the Software (ii) 
reactivated periodically thereafter by verifying your 
licence details to confi rm you are using the Software 
in accordance with these Licence terms;

if you have a subscription version, have the Software (iii) 
reactivated (on payment of Reckon’s renewal fee 
and verifi cation of your licence details) if you wish to 
renew the subscription;

have the Software reactivated by Reckon if you wish (iv) 
to re-install the Software (for example, if you would 
like to install the Software on a new computer or if 
you have a hard drive failure and need to reload your 
Software); and

provide to Reckon the details of your installation key (v) 
code and product key code for the Software as part of 
the reactivation process.

You agree to activate or reactivate the Software within 
a reasonable time or within such time as the Software 
prompts you to do so.
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Key codes(b) : Each copy of the Software is provided with 
a unique installation key code (which may appear on 
the packaging or the cover of the media on which the 
Software is contained). You should keep the installation 
key code safe. As per clause 3(a)(v), you will be required 
to provide your installation key code to Reckon when you 
reactivate your Software.

Manner of verifi cation(c) : You must verify your licence details 
in the manner required by Reckon from time to time 
(which may include email or on-line registration via the 
Internet). The Software may prompt you as to the required 
manner of verifi cation.

Charges for reactivation(d) : Reckon will not charge you 
to activate the Software initially or to reactivate your 
Software when you verify your licence details or renew 
a subscription, unless you have lost your installation or 
licence key code. You need both your installation code 
and your licence key to be able to reactivate the Software. 
Reckon may charge you a fee for technical support to 
reissue a licence key code. Reckon may also charge a 
fee for technical support if you need to reactivate the 
Software in other circumstances (for example, if you 
need to reinstall the Software because you have a new 
computer or need to reload the Software due to a hard 
drive failure). For the current fees go to http://www.
quicken.com.au. If you have lost your installation key 
code, Reckon will not replace that code, and you may be 
required to purchase new Software.

Consequences of non-renewal and failure to verify details(e) : 
This Software is provided to you on the understanding 
and acknowledgment that it may contain technology 
which deactivates and disables the Software if a 
subscription is not renewed or in the case of a full 
licence version, you have not verifi ed your licence details 
when periodically prompted to do so by Reckon or by the 
Software. If the Software is not reactivated within the 
required period, the Software may continue to operate 
but with impaired functionality or you may not be able 
to access the Software at all (including printing out or 
viewing any of your data or records).

Statutory declaration(f) : In certain circumstances, before 
permitting a re-activation, Reckon may require you to 
provide it with a Statutory Declaration stating the reasons 
for re-activation in a form required by Reckon.

Older versions(g) : Reckon has a sunset policy (covered in 
more detail in clause 4(a)) which means that technical 
support is not available for certain older versions of the 
Software. If technical support is not available for your 
version, you will not be able to reactivate or reinstall 
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your Software if you do not have your installation key 
code. Reckon will not be obliged to provide you with a 
replacement key code and in those circumstances you 
will need to purchase a new version or Upgrade in order 
to continue using the Software. Please go to http://www.
quicken.com.au to see the sunset policy. 

4. TECHNICAL SUPPORT 

Period when technical support is available(a) : Reckon will 
provide technical support for the Software only (and for 
the avoidance of doubt this does not include support 
for third party hardware or software, which remains the 
responsibility of the relevant third party), during the 
following periods: 

in the case of a subscription version of the Software, (i) 
during the period for which you have paid the relevant 
subscription fees (unless further releases of the 
Software in question are discontinued); and

in the case of a full version of the Software, there is (ii) 
a ‘sunset period’ during which technical support may 
not be available for that version. The sunset period 
for a version will commence on the earlier of:

2 years after the date on which you fi rst installed (A) 
the version on your computer; or

the date Reckon releases the second successive (B) 
Upgrade to that version.

For further explanation of Reckon’s sunset policy 
please go to http://www.quicken.com.au.

What is included as part of technical support(b) : Reckon will 
provide technical support in accordance with its then 
current technical support policy, which may include:

as contemplated by clause 3, the technical support (i) 
required to reactivate the Software or to issue a 
replacement registration key code (for example, when 
you verify your licence details, renew a subscription or 
if you need to reinstall the Software);

provision of telephone help desk support services;(ii) 

access to technical information about the software (iii) 
contained on Reckon’s website; and

the ability for you to download Updates,(iv) 

but it does not include provision of Upgrades of 
the Software. For further explanation of Reckon’s 
technical support policy please go to http://www.
quicken.com.au. 

Fees(c) : Clause 3(d) sets out the circumstances when you 
will (and when you will not) be required to pay charges 
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for the technical support to reactivate your Software 
(including when you wish to reinstall the Software) or for 
Reckon to issue a replacement registration key code. 

For all other technical support, Reckon may charge you a fee 
in accordance with its then current technical support policy.

5. ONLINE SERVICES

Interaction with Online Services(a) : The Software may contain 
access to, or features that interface with, online services 
(“Online Services”).  Examples of Online Services that 
may be applicable to the Software are EFTPOS, an online 
share price download facility, a statement download 
facility, bill and other payment services, a superannuation 
choice facility, online backup facility, payroll services and 
a debt recovery facility which are provided at an additional 
charge on a subscription basis measured for one year 
from the date of registration.

Terms for Online Services(b) : Certain Online Services are not 
available for all versions of the Software. For example, 
in the case of bank statement download services, not 
all banks provide services that connect to the Software.  
Online Services are only available for 12-month periods 
for subscription versions and 24-month periods for full 
versions. In the case of a full version, access to Online 
Services in the second 12-month period may be subject 
to payment of the applicable charges. In order to renew 
access to Online Services at the end of the 24-month 
period in the case of a full version, you will be required 
to have purchased or upgraded to the latest version of 
the Software. In the case of a subscription version, you 
must have renewed your subscription.  Internet access 
is required for all Online Services.  Charges may apply 
for the use of Online Services (in addition to the cost 
of Internet access levied by your ISP).  Where Online 
Services are available, separate terms and conditions 
with the provider of the Online Services may apply.  In 
some cases Reckon may be the provider. You should 
check with the relevant third party provider as to the 
terms and conditions of use.  Access to Online Services 
may be withdrawn by Reckon at any time.  Reckon will 
not be liable for the withdrawal of access to any Online 
Services.  Where access is to be withdrawn, Reckon 
may choose to notify you in advance provided that you 
have supplied Reckon with a valid and up to date email 
address. 

Other third party services and applications(c) : In some cases 
you may download other third party applications, for 
example Google Desktop supplied by Google Inc. In such 
cases your agreement to be bound by the terms of this 
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Licence will also bind you to the terms of use or other 
similar agreements required by such third parties for use 
of their products.

6. LIMITED WARRANTY

Software provided on an ‘as is’ basis(a) : Subject to clause 
7(b), Reckon provides the Software to you on an “as 
is” basis and without any representations by Reckon 
or any of its authorised distributors regarding the use, 
performance, or results of the use of the Software.

Defects in media(b) : Reckon warrants that the media on 
which the Software is recorded is free from defects in 
manufacture for a period of 90 days from the date of 
delivery.  During this period, if you return the Software 
to your place of purchase, Reckon will replace any 
defective media on which the Software was supplied and 
any Software on that media, free of charge, unless you 
caused damage to the media due to poor handling.

No guarantee that Software will be error free or that its (c) 
use will be uninterrupted: While Reckon has endeavoured 
to make sure that the Software works substantially as per 
the specifi cations published by Reckon from time to time, 
Reckon does not guarantee that the Software will work 
on all computer hardware platforms or confi gurations and 
makes no warranty that the Software will be error free, 
that its use will be uninterrupted or that it will be fi t for 
your purpose.

Internet access, telecommunications networks, fi rewalls (d) 
and security: Reckon does not guarantee connections to 
its online activation server as these may be dependent 
upon third party networks and security measures over 
which Reckon has no control. 

7. LIABILITY

Certain rights cannot be excluded(a) : The Trade Practices 
Act, 1974, and other laws may imply certain conditions 
and warranties into this Licence and give you certain 
rights and remedies that cannot be excluded or modifi ed.  
This clause 7, and the limited warranties provided in 
clause 6, do not exclude or modify any of those rights if 
to do so would contravene that law or make any part of 
this Licence void.

Exclusion of warranties(b) : To the full extent permitted by 
law, Reckon excludes all conditions, warranties and rights 
that may be implied into this Licence.  If conditions, 
warranties or other rights for your benefi t are implied in 
this Licence or otherwise conferred by law and it is not 
lawful to exclude, restrict or modify them, then those 



35

conditions, warranties and other rights will (but only to 
the extent required by law) apply to this Licence.  

Limitation of implied terms(c) : Reckon’s (and its 
distributors’) liability for breach of any implied conditions 
or warranties that cannot be excluded is limited, to the 
extent permitted by law and at the option of Reckon, to 
replacing or re-supplying the goods or services or their 
equivalent again or the payment of the cost of having the 
goods or services or their equivalent replaced or supplied 
again.

General exclusion and limitation(d) : Other than as set out in 
clauses 7(b) and 7(c), and to the full extent permitted by 
law:

Reckon (and its authorised distributors) will not be (i) 
liable to you or any other person for any direct or 
indirect loss, damages, liability, costs or expenses 
suffered by you or any other person relating to the 
performance or non-performance of the Software 
or any breach of this Licence or the supply of the 
Software or in connection with, but not limited to, 
the Online Services, use of tax tables, use of third 
party hardware (for example but not limited to Postec 
services) or provision of technical support (whether 
by telephone or remote access or other means); and

Reckon’s maximum liability for damages arising in (ii) 
connection with this Licence or the supply of the 
Software is limited to the amount paid by you for the 
Software.

Your liability to Reckon(e) : You agree that Reckon (and its 
authorised distributors) will not be liable, other than 
as expressly set out in this Licence, and that you will 
indemnify Reckon (and its authorised distributors) from 
any liability, loss, damage, costs or expenses which you 
may suffer or incur as a result of your use of the Software 
(including any claims made against you by third parties).

Use of Software is not provision of professional advice(f) : 
The information contained in this Software may include 
features designed to assist you in complying with 
the requirements of the relevant legislation; e.g., 
superannuation. If the Software contains features 
to assist with superannuation, e.g., superannuation 
guarantee requirements, then Reckon does not warrant 
that the relevant reports will be compliant with legal 
requirements, as these change from time to time. You 
agree it is your obligation to ensure that deductions and 
rates used for deductions for superannuation, taxation 
(of any nature) and any other deductions/contributions 
calculated using the software are correct from time to 
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time and at the applicable time and that nothing in the 
software constitutes professional advice in relation 
to these matters. The help contained in this Software 
is not a substitute for professional advice.  Legal and 
accounting advice should be obtained before taking any 
action in reliance on this Software. The software is also 
not fi nancial product advice. In addition any tax tables 
(which are included with certain versions of the Software, 
e.g., QuickBooks and Payroll Premier) that might be 
supplied with this Software are also changed from time 
to time and you should consult with your professional 
adviser before relying on the tax tables.  Reckon does 
not warrant that the tax tables are up to date at your 
date of purchase.  In providing you with the tax tables, 
Reckon is not engaged in rendering legal, accounting or 
other professional services. If legal advice or other expert 
assistance is required, you should seek the service of a 
competent professional.

Reckon has no responsibility for recommendations(g) : 
Reckon, its employees, agents, contractors and the 
authors disclaim any and all liability and responsibility 
to any person, whether a user of this Software or not, 
in respect of anything (including, without limitation, 
any error in or omission from this Software) and of the 
consequences of any actions taken or omitted to be 
taken in reliance, whether wholly or partially, upon all 
or any part of the content, recommendations or help 
contained in this Software.

Corruption of data and on-line access(h) : To the full extent 
permitted by law, Reckon and its authorised distributors 
disclaim all liability for any corruption of data, inability to 
access data, loss of data, breach of privacy, or downtime 
as a result of or arising from the use of any online link 
available between the Software and another server 
including without limitation in connection with any Online 
Services.

On-line services(i) : Reckon makes no warranty or 
representation in connection with the Online Services, the 
responsibility for which rests with the relevant provider of 
such Online Services.

8. TERM AND TERMINATION OF LICENCE

Licence Term(a) : Unless this Licence is terminated earlier in 
accordance with its terms, your right to use the Software 
in accordance with this Licence continues:

in the case of a subscription version of the Software, (i) 
for an initial period of 12 months from the date 
of registration of the Software.  This Licence will 
automatically renew for a further 12 month period 
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upon the payment of Reckon’s annual subscription 
fee.  If the annual subscription fee is not paid on 
or before the termination of the current 12 month 
period, this Licence will automatically terminate; and

in the full version of the Software, indefi nitely, (ii) 
however:

you may be required to periodically verify your (A) 
licence details and have the Software reactivated 
as per clause 3 in order to keep using the 
Software; and

if you need to reinstall the Software, you will (B) 
need a copy of your original CD (or other media 
on which the Software was provided) and the 
installation key code.  If you do not have the CD, 
you will need to purchase or upgrade to a new full 
version and pay for the postage associated with 
sending the CD to you. Clauses 3(d) and 3(g) 
outline when Reckon may charge you a fee for the 
provision of a replacement key code and, more 
importantly, when a replacement key code will not 
be provided by Reckon due to the operation of 
Reckon’s sunset policy.

Termination by Reckon for breach(b) : Reckon may terminate 
this Licence if you are in breach of its terms or as 
otherwise set out in this Licence.

Survival(c) : Clauses 2, 4, 6, 7 and this clause 8 will survive 
the termination of this Licence. Termination of this 
Licence will not prejudice any right which Reckon may 
have, or but for the termination may have had, against 
you for a breach of this Licence.

Things you must do upon termination(d) : Upon the 
termination of this Licence, you or your representative 
must promptly uninstall the Software from your computer, 
destroy the CD, User Guide and related materials and any 
copies of them in your possession or control or return 
or dispose of them in the manner directed by Reckon.  
Upon written request from Reckon you agree to provide a 
Statutory Declaration to Reckon that you have complied 
with your obligations under this clause 8(d).

9. SUBSCRIPTION TERMS

If you have purchased a subscription version of the Software, 
this additional clause 9 will apply.

Entitlement to Upgrades and Updates(a) : During the period 
for which you have paid subscription fees you will receive, 
included in the cost of the subscription, all Upgrades 
and/or Updates of the Software, via Internet download.
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No extension of Licence term(b) : Your right and entitlement 
to use the Software, as enhanced by any Upgrades and/
or Updates, concludes at the end of the term of the 
Licence (subject to payment of an annual subscription 
fee) and is not linked to the dates of release, registration 
or provision by Reckon of any Upgrades and/or Updates.

This Licence prevails(c) : If you have purchased this Software 
as an Upgrade to an earlier version of the Software, this 
Licence shall supersede any previous licence agreement.

Not all Upgrades included(d) : Your subscription to the 
Software and any Upgrades and/or Updates under this 
Licence does not grant you the right to receive special 
versions of the Software created for certain customers 
or market segments, even though they may contain 
similar features or functions.  Versions of the Software 
which may from time to time be offered in retail or other 
channels in different confi gurations as special promotions 
are not included as part of the subscription.

No obligation on Reckon to upgrade(e) : Upgrades and/
or Updates will be developed and released by Reckon 
in its sole discretion, and Reckon does not warrant or 
represent that it will develop or release any Upgrades 
and/or Updates during the term of the subscription 
period or Licence.  Furthermore, Reckon does not warrant 
that the Upgrades and/or Updates will be provided to 
you or made available within any specifi ed time period 
following the commercial release of such Upgrades and/
or Updates.

When payment is due(f) : If applicable to the Software 
licensed to you, you will be required to pay the monthly 
subscription fee in advance on the fi rst business day 
of each month.  You authorise Reckon to direct debit 
your monthly subscription fee from the bank account 
nominated by you.

Deactivation at end of subscription period(g) : As per clause 
3, the subscription version of the Software is provided 
to you on the understanding and acknowledgment that it 
may contain technology which deactivates and disables 
the software if your subscription is not renewed or you 
are found to be in breach of this license agreement If 
the Software is not renewed by the end of the required 
period, the Software may continue to operate but with 
impaired functionality or you may not be able to access 
the Software at all (including printing out or viewing any of 
your data or records).

You need a full version if you don’t renew(h) : If you elect 
not to renew your subscription, the Software does not 
allow you to upgrade to a non-subscription version of the 
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Software by way of the purchase of an Upgrade pack.  
In such circumstances, you are only able to upgrade 
to a later non-subscription version of the Software by 
purchasing a full (non-upgrade) version of the Software.

Early termination(i) : If you wish to terminate your 
subscription early, you must do so by giving Reckon 
no less than one calendar month notice to that effect.  
Depending on the type of software you have subscribed 
to and the type of subscription you are signed up for, you 
may be required to pay a cancellation fee.  See http://
www.quicken.com.au for a schedule of fees.  Reckon 
will direct debit your account, and you agree to pay, the 
applicable cancellation fee.

10. TRIAL LICENCE

If you have been provided with a Trial Version of the Software, 
this clause 10 sets out the terms that will apply to your use of 
the Trial Version.

Licence(a) : Your licence to use the Trial Version:

permits you to evaluate the Software’s functionality (i) 
and suitability for your requirements;

is for the number of users set out in the material (ii) 
accompanying your copy of the Trial Version;

is subject to the general restrictions in clause 2(e) (iii) 
and the limited warranty in clause 6(a);

is for three months ((iv) Evaluation Period); and

in the case of Reckon Retail Point of Sale, does not (v) 
integrate with QuickBooks.

Duration(b) : You acknowledge that your licence to use the 
Trial Version will only apply for the Evaluation Period. At 
the end of the Evaluation Period:

you must not and will not be able to continue to (i) 
access the Trial Version, including any data that you 
have entered into the Trial Version; and

if you wish to use the Software you must purchase a (ii) 
full version or subscription version of the Software.

Entitlements(c) : You:

are not entitled to Upgrades or Updates (or any other (i) 
software other than the Trial Version); and

may be required to pay for any technical support (ii) 
that you may require in relation to the Trial Version in 
accordance with Reckon’s then current charges.

Liability: You acknowledge that subject to clauses 7(b) (d) 
and 7(c), and to the full extent permitted by law, Reckon 
excludes all liability to you for any loss, damage, liability, 
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costs or expenses suffered by you relating to the 
performance or non-performance of the Trial Version or 
any breach of this clause 10.

11. STUDENT EDITION

If you are using a Student Edition, your Software may (a) 
have limited licence rights as well as limited functionality, 
including:

a limit on the number of transactions that can be (i) 
entered;

a limit on the number of company fi les that can be (ii) 
opened;

a limit on the number of QuickBooks features and (iii) 
services available.

Your Software may be deactivated at the end of three (b) 
years from the date of installation and this may prevent 
access to the Software and data unless an appropriate 
upgrade is purchased.

There is no support available for the Student Edition.  (c) 
Support requests must be directed to your educational 
institution.

Reckon does not warrant that any information in the (d) 
Software is up to date, for example functionality required 
for certain lessons involving tax tables or payroll tax, 
and it is your sole responsibility to check with your 
educational institution whether any information is up to 
date.

12. GENERAL

Some defi ned terms(a) : In this Licence:

Trial Version means Software that has been provided to 
you on a temporary basis in order to carry out a trial of 
that Software to determine whether you wish to use the 
Software on an ongoing basis.

Student Version means Software that is licensed to you 
as part of your educational institution’s arrangement with 
Reckon or Software that you have purchased that Reckon 
has determined is a Student Version.

Upgrade means a new version of the Software which 
contains additional functionality or other enhancements.   
Reckon will determine whether a new version constitutes 
an Upgrade or an Update.

Update means a new version of the Software which 
contains minor enhancements.

Applicable law(b) : This Licence is governed by the laws of 
the State of New South Wales, Australia.
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Entire Agreement(c) : This Licence contains the entire 
agreement between Reckon and you in relation to its 
subject matter and supersedes any prior agreements and 
understandings, whether written or oral.

Waiver(d) : Any failure to enforce any rights under this 
Licence by Reckon is not to be taken as a waiver of those 
rights.

Variation(e) : To the extent permitted by law, Reckon may 
vary any of the terms and conditions of this Licence 
upon providing you with thirty (30) days notice in writing 
and a copy of the replacement terms and conditions.  In 
the case of subscription users no new terms will come 
into force until the commencement of your renewed 
subscription period. Reckon will display any new terms 
and conditions on Reckon’s web site and you should 
check the QuickBooks website regularly. See http://www.
quicken.com.au.

Headings(f) : Clause headings are for ease of reference only 
and do not affect the meaning of this Licence.

Third Party Applications and Technology(g) : in some versions 
of the Software, you may in the installation process also 
have installed third party applications and technology. 
The terms of this Licence apply to your use of all such 
third party applications and technology.

Quicken and QuickBooks are registered trademarks of Intuit Inc.

Software is © 2009-10, Reckon Limited.

All rights reserved.
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Store your Quicken products safely

Your unique Licence Key and Quicken 2009 CD are 
extremely valuable and may be required to reactivate or 
reinstall the software. Please keep your Licence Key in a 
safe place with your Quicken 2009 CD. If you lose your 
Licence Key or CD, they will be replaced only while this 
version of the software is supported, and administrative 
charges may apply.

Product updates available online

Reckon regularly posts product news, announcements, 
and other information of interest to QuickBooks users on 
our website, http://www.quicken.com.au.

From the website, you can download product-related fi les, 
such as software service packs and product updates. 
To keep your software secure and up-to-date, visit the 
website regularly.

You must be a current Advantage or Subscription 
customer, using the latest version of the software 
in order to access these fi les. This also applies to 
replacement updates if they are lost, for example by a 
hardware failure. To avoid potential problems, be sure to 
keep your Annual Membership up to date.



43

Your important reference numbers

Customer ID:

Customer PIN:

Installation Key Code:

Installation Computer/

User

Product Key Licence Key

Example Reception 10030-59821-
00858-381

36934-42890-
33878-21990

PC 1

PC 2

PC 3

PC 4

PC 5

You will need these numbers for re-registration purposes. 
Please have these details on hand when contacting 
Reckon.

To fi nd these details in Quicken, go to the Help menu and 
click My Licence Information.

My original CD is safely stored here:



Contacting Reckon 

Technical Support

Australia

For installation and software support, Technical Support 

is available Monday to Friday, 9.00am – 5.00pm AEST. 

Weekend support is also available, check website for 

opening hours. Extended hours are available to Reckon 

Advantage members.

1902 223 101 (Advantage members, please refer to 

your Welcome Pack for Advantage technical support 

contact details)

Call costs $4.90/min (incl GST) Charges are higher 

from public and mobile phones. Call costs and 

operating hours are subject to change.

www.quicken.com.au/support

New Zealand

Technical support is available Monday to Friday, 

9.00am – 5.00pm NZ.

Per incident support 0800 933 666

$35.00 plus GST

 Per minute support 0900 33 609 

Call cost – $3.95 /min (incl GST)

Charges are higher from public and mobile 

phones. Call costs and operating hours are 

subject to change.

www.quicken.co.nz

Asia

Technical support is available Monday to Friday, from 

9.00am – 5.00pm at US$40 per incident support.

Singapore +65 6254 2322

www.quicken-asia.com
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